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Enhancements
1. Automatic Generation of Moving Train Loads for Dynamic Analysis

2. Debonded Length of Pretensioned Beam

3. Correction of Tendon Force/Stress within Transfer Length of Pretensioned Beams

4. Moving Load Analysis including Centrifugal Force Effects to AASHTO LRFD

5. Update to CS 454 revision 1 for the UK Bridge Assessment

6. Application of Combined Special Vehicle and ALL model 1 for CS 454 Assessment

7. Separate the Results of Combined Vehicles for CS 454 Assessment

8. Pretensioned Beam Design at Transfer to AS 5100.5

9. Transmission Zone Design of Pretensioned Beam to AS 5100.5

10. Crack control for the Slab of PSC Composite Girder to AS 5100.5

11. Joint Check of Segmental Construction to BS 5400.4

12. Response Spectrum Function : IRC SP 114:2018

13. Auto Temperature Gradient as per IRC 6:2017

14. Improvement in Auto Load combinations as per IRC 6:2017

15. Update in General Section Designer as per IRS Specifications
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1. Automatic Generation of Moving Train Loads for Dynamic Analysis
• Generatetime-forcingfunctionswithoutconsideringthe lengths of the elementalong the track.The requirednodalspacing along the track is automaticallydetected by the program.
• Auto-generatetime-forcingfunction anddynamicnodal loadsrepresentingmovingtrain loads. Previously,dynamicnodal loadshad to be definedby the user manually.
• This function replacesTools>Generator>DataGenerator>TrainLoadGenerator.

Train Load Generator

Dynamic Nodal Loads

 Load > Dynamic Loads  > Time History Analysis Data > Train Load Generator

Define

Tracks
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2. Debonded Length of Pretensioned Beam
• Debondedlength of pretensionedbeamcan be directlydefinedwhencreatingstrandsfromthe TendonProfiledialog box.
• Define the actualwhole lengthof stand includingdebondedpartsat bothends and then enter the lengthsfor debondedparts.

 Load > Temp./Prestress> Prestress Loads> Tendon Profile

Tendon Profile

Tendon Primary Moment Diagram

Display of debonded strands
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• Debondedlength andtransfer length can be modifiedfor the multiplestrandsat one time.

 Load > Temp./Prestress > Prestress Loads > Tendon Profile > Change Tendon Profile

2. Debonded Length of Pretensioned Beam

Change Tendon Profile
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3. Correction of Tendon Force/Stress within Transfer Length of Pretensioned Beams

Idealized steel-stress development in PSC member

• The stress in the prestressingsteel is assumedto vary linearlyfrom0.0 at the pointwherebondingcommences, to the effective stressafter losses at the end of the transfer length.

 Load > Temp./Prestress > Tendon Profile

Pre-tension

type

Transfer

Length

Tendon Profile
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3. Correction of Tendon Force/Stress within Transfer Length of Pretensioned Beams

 Result > Bridge > Tendon Loss Graph

• Tendonstresses after immediateloss aredeterminedlinearlywiththe transfer length, and then losses due to creep,shrinkageandrelaxationwillbe calculated alongthe time.
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4. Moving Load Analysis including Centrifugal Force Effects to AASHTO LRFD
• The overturning component of centrifugal force is now taken into account during the moving load analysis. The results of vehicle application will be the combination of vertical effect and

overturning effect of the vehicle. The overturning component causes the exterior wheel line to apply more than half the weight of the truck and the interior wheel line to apply less than half
the weightof the truck by the same amount.

• In orderto applycentrifugal forces, the ‘AddCentrifugalForce’optionshouldbe checked on fromthe Vehicle definitionas wellas TrafficLine/SurfaceLane.

 Load > Moving Load Code> AASHTO LRFD

Traffic Line Lane VehicleVehicular Centrifugal Force Wheel-Load Reactions

Moving Load Tracer

RCL = 0.6W        RCR = 0.4W
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5. Update to CS 454 revision 1 for the UK Bridge Assessment
• CS 454 revision1 Assessment of highwaybridgesand structures

• The existing CS454/19is replacedby CS454/20.Referencesin the reportarechanged from BD 86/11,BD 44/15 to CS 458, CS 455, respectively.

CS 454/19 Report CS 454/20 Report

 Rating > Bridge Rating Design > PSC Bridge> Design Code for Assessment
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5. Update to CS 454 revision 1 for the UK Bridge Assessment
• Changes in CS 455:The assessmentof concrete highway bridgesandstructures(formerlyBD 44/15)

1) The compressivestress limitof composite beamis changed.

BD 44/15

CS 455
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5. Update to CS 454 revision 1 for the UK Bridge Assessment
2) The tensilestress limitof pre-tensionedclass 3 members is changed.

BD 44/15

CS 455
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5. Update to CS 454 revision 1 for the UK Bridge Assessment
3) When additionalreinforcementis containedwithinthe tensionzone,the provisionof increase in the tensile stress limitof pre-tensionedclass 3 membersis removed.

BD 44/15 referring to BS 5400-4
CS 455

Removed
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5. Update to CS 454 revision 1 for the UK Bridge Assessment
4) Some formulaefor ULS shear check arechanged.
5) The verticalcomponentof the prestressingforce may be addedto Vmaxas per clause 8.20.2.Additionaloptionis introducedto considerthis change.

BD 44/15

CS 455

+ Pv

ULS Shear check

Option in Assessment Parameter
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6. Application of Combined Special Vehicle and ALL model 1 for CS 454 Assessment
• CS 454:Assessment of highwaybridgesand structures
• ALL mode 1 (single or convoy)can be appliedalong withspecialvehicle or HB load.

Moving Load Case Dialog Box Moving Load Tracer

 Load > Moving Load Code> BS

 Load > Moving Load Analysis Data> Moving Load Cases

Combined SV and ALL model 1

Remaining area

ALL model 1 Convoy

HB load

ALL model 1 Convoy
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7. Separate the Results of Combined Vehicles for CS 454 Assessment
• The resultsof combinedspecialvehicle andALL modelcan be viewedseparatelyby vehicles.
• This is useful whencalculatingreservefactors for specialvehiclesappliedtogetherwith ALL model1 or 2.

 Load > Moving Load Code> BS                          Results > Result Tables > Beam > Forces

Moving Load Case S*S*
ST

Combined Vehicles

View by Load Cases

View by Max Value

• SV reserve factor
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8. Pretensioned Beam Design at Transfer to AS 5100.5
• Pretensionedbeamdesignat transfer is providedas per clause 8.1.6.2 and8.6.2 of AS 5100.5.
• Loadcombinationtype for transfercheck is added.
• Compressivestrength, fcp duringtransferneedsto be definedmanuallyfor the design checks.

Load Combination

 PSC > Design Parameter> AS 5100.5: 17

Transfer Load CombinationManual input option for strength at transfer
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8. Pretensioned Beam Design at Transfer to AS 5100.5
• Compressivestress of concrete andcrack controlare checked.
• Excel reportandtable summaryare provided.

 PSC > Design Parameter> AS 5100.5: 17

Check Crack Control at Transfer

Transfer Check in Excel Report

Check Compressive Stress at Transfer



18 / 27

Civil 2021 (v1.1)  Release NoteCivil 2021

9. Transmission Zone Design of Pretensioned Beam to AS 5100.5
• Pretensionedbeamdesign is performedconsidering stressdevelopmentin tendons as a bi-linearrelationshipdefinedby the transmissionlengthand developmentlengthas per AS 5100.5.
• Flexuralresistance at ULS withindevelopmentlength.

 PSC > Design Parameter> AS 5100.5: 17

Stresses in the Tendon at ULS

Flexural Resistance Diagram

Development Length in Report

Transfer Length & Development Length

Tendon stress at ULS within development length
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9. Transmission Zone Design of Pretensioned Beam to AS 5100.5
• Shear resistanceat ULS withintransmissionlength.

 Load > Temp./Prestress > Tendon Profile

Shear Resistance Diagram

Tendon stress fpo within transfer length

 Stress in prestressed tendon when stress 

in surrounding concrete is zero



20 / 27

Civil 2021 (v1.1)  Release NoteCivil 2021

10. Crack Control for the Slab of PSC Composite Girder to AS5100.5

• Slab crackcontrolas per clause 8.6.1. is providedfor PSC composite beams.Slab crack reviewcontrolledprimarily in flexureat the top of the Slab.

 PSC > Design Parameter> AS 5100.5

• Load Effect considered for two cases:-

• a) SLS Load Combination

• b) For Beams designed for exposure classifications B2, C1, 
C2, and U, permanent effects at the SLS.

Rebar stress limit based on 8.6.1 (A), (B).
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10. Crack control for flexure at Service for the Slab of PSC Composite Beam to AS5100.5

• For rebarstress check due to SLS loadcombination,rebarstress for Exposureclass A, B1 comparedwith left columnstress limitvalueof Table 8.6.1 (A), (B).
• For Rebarstress check due to permanenteffects at the SLS, rebarstress for Exposureclass B2, C1, C2 and U, comparedwith rightcolumn stress limit valueof Table 8.6.1 (A), (B).

 PSC > Design Parameter> AS 5100.5

Rebar Stress under Negative Moment (SLS) Rebar Stress under Negative Moment (Permanent Effect of SLS)
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11. Joint Check of Segmental Construction to BS 5400.4
• Shear check andstress check at the jointof segmentalconstructionare providedas per clause 6.3.4.6 and7.3.3 of BS 5400.4,respectively.

 PSC > Design Parameter> BS 5400.4

Joint Shear Resistance Joint Shear Stress Limit
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11. Joint Check of Segmental Construction to BS 5400.4

 PSC > Design Parameter> BS 5400.4

Joint Shear Resistance

• Shear check providestwo results:member shearreviewand joint shearreview.

• Segment Joint recognitionis determinedby the PSC Segment AssignmentFunction.

• Serviceability check: the flexural stresses in the joint should be compressive 
through and  stress limit is different depending upon Joint Type 
(Resin/Cement). 0 MPa is for resin and 1.5 MPa for cement.

Joint Shear Stress Limit



24 / 27

Civil 2021 (v1.1)  Release NoteCivil 2021

12. Response Spectrum Function : IRC SP 114:2018

 Load > Dynamic Loads > RS Functions

• New responsespectrumfunctionguidelinesfor seismic design of roadbridgesas per IRC SP 114:2018

• In this version,the Responsespectrumfunction can be modifiedas per user definedZone Factor, ImportanceFactor andResponse Reductionfactor values

• Modificationof Auto loadcombinationas per IRC 6-2017consideringthe response spectrumcases given in IRC SP 114:2018

Response Spectrum Functions Design Spectrum inputs 
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13. Auto Temperature Gradient as per IRC 6:2017

 Load > Temp/Prestress> Beam Section Temperature

• Auto definitionof TemperatureGradientfor PSC andSteel composite girdersas per IRC 6:2017.

• Applicablefor section definedfromPSC, Compositetab (notapplicablefor SPC and Valuetype sections).

Beam Section Temperature Auto option as per code provision
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14. Improvement in Auto Load combinations as per IRC 6:2017

 Results > Load Combinations > Auto Generation

• Improvementin Auto Loadcombinationsof Temperatureloadfactors (TemperatureuniformandTemperaturegradient loads).

• Updates in loadfactors for combinationsconsidered for Special Vehicle as per IRC 6:2017Amendments.

Auto Generation of Load Combination Special Vehicle provision
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15. Update in General Section Designer as per IRS Specifications 

 Tools > General Section Designer

• Ultimate check for P-M Interactionand Serviceabilitycheckfor stressesand crackwidth as per IRS Concrete code.

• Improvementin materialdata base as per IRS Concretecode.

Design parameter as per IRS ULS and SLS Checks as per IRS


